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Congratulations on your purchase of one of rocketry’s smallest altimeters.
You will find that this unit is very easy to use.
Allow me to go over some of the highlights of the unit here.
This unit is a peak reporting altimeter that reports the maximum altitude reached.
And with the built in memory you can record the flight as well.
Contents:
1) Pico alt unit
2) This manual
Operation:
1) Install/connect battery.
2) The previous flight will be reported though a series of flashes on the LED.
3) Install unit in electronics bay.
4) Wait the pre-launch delay time then launch.
5) After flight remove battery to turn off.
6) Reconnect battery for altitude report.
7) After a full day of flying download all flights when you get home.
Power Source
This altimeter was designed to have flexibility of the power source to allow the modeler
to choose the best power supply for his application. It can be run off a 12V A23 type
battery. Or you may choose to power it from a 9V battery to give longer run times
between battery changes. It can also support 3.7V LiPo batteries.
Installing in rocket
This unit is a barometric reading unit. As such it requires a vent hole in the electronics
bay so that it can read atmospheric pressure. The size of these holes is dependant upon
your bay size.
This bay must also be sealed from the ejection gasses that occur during motor ejection
charge firing. The altimeter must be protected from these gasses as they are corrosive and
can damage the unit.
Mounting of the unit is going to be dependent upon your electronics bay design.
If you are using a small rocket then you might just slip it into the bay battery first and put
some tissue lightly over the top to hold it in place.
In a larger airframe you might be able to lightly wrap some paper towel around the unit
and battery and slip it into the bay.
Any design that allows the unit to measure the pressure changes as the rocket changes
altitude will be fine.
Be sure to secure the battery in its holder with tape.
If your battery holder has springs install it so the spring of the battery holder is toward the
nose cone.
This way the force of liftoff is not pressing down on the spring.

Altitude readout
The altitude is read out as a series of flashes on the LED. The unit uses a high brightness
LED that is easily readable in bright sunlight.
It blinks out the altitude in decimal digits starting with ten thousands then thousands,
hundreds, tens and ones.
The unit will not report leading zeros.
The number of blinks indicates the number for that decade with a zero being represented
by 10 blinks.
Each decade will blink out then there will be a slight pause before the next value.
At the end of the readout there will be a quick double flash telling you the unit is
preparing itself for launch detect. If you are only reading out the data then at this point
just power off the altimeter.
Battery life
The average current consumption of this unit is 6mA.
An Energizer A23 cell has a capacity of 40mAh.
This should give a full day of flying.
If you are using another cell simply divide it’s mAh rating by 6 to give an estimate of the
expected battery life.
Sensor
The sensor is sensitive to sunlight as well as pressure. The introduction of sunlight into
the sensor will temporarily change the reading due to the thermal heating of the sensor
element. This is only an issue if the sunlight is allowed to enter the sensor and heat the
element inside it that makes the measurement. It is also only lasts as long as the sunlight
is heating the sensor. To prevent this from effecting the operation there is an adjustable
pre-launch delay, after the altimeter is done reporting the last flight, before the ground
altitude is read.
Misc
There is a user adjustable pre-launch delay after completion of the altitude report before
the sensor makes its initial reading. This delay is to allow you to install the altimeter in
your rocket.
Be sure that the rocket is not launched until this delay has ended or you may get a low
altitude report or no altitude report.
The launch detect is also user defined. If the rocket does not reach the launch detect
altitude it will not erase the last flight data. This means that if you rocket does not go
higher than the launch detect altitude then the altimeter will not record the flight.

Battery connection
The 3 pin terminal block is used for battery connection.
Pin 1 is for the negative(-) side of your battery so connect it there. If you plan to remove
the battery from it’s connector as a means of power control then connect the positive(+)
battery lead to pin 2. Then simply connecting the 9V battery to it’s snap will be your
means of power control.
Pin 3 of the terminal block has no electrical connection to the altimeter.
If you have need of a remote power switch then you can connect the battery lead to pin 3
of the terminal block. This allows you to connect a switch between pin 2 and 3 to use as a
power switch.
Alternatively you can connect the leads from your battery to the solder pads below the
terminal block. These are labeled + and –. The – pad connects to terminal 1 and the + pad
connects to terminal 3. With this connection you can use terminal block pins 2 and 3 to
connect a switch. This setup is useful if you are using a LiPo battery.
Polymer Lithium Ion batteries (LiPo) are high energy density batteries. The new
generation of LO4 with the 3 terminal block have been designed to run off these 3.7V
batteries. These are available through many online retailers and I recommend
www.sparkfun.com for batteries and a good LiPo charger.
The altimeter does not have the facility to detect battery voltage so be sure to not let the
altimeter drain your battery too low. The regulator should cut out at 3V reducing the
current draw from the altimeter but it will still draw some current so be sure to disconnect
power.
A small LiPo battery can be connected to the bottom of the board with it’s leads soldered
to the pads supplied. Be sure to insulate any connections so they can not short out from
the battery leads or possibly a conductive battery case. And when securing the battery to
the board do not cover the pressure sensor hole with tape or shrink tube.
Now with the battery connected you can use terminal block pins 2 & 3 as a power switch
to connect/disconnect the battery.
You can also use pin 1(-) and pin 3(+) to connect your charger and charge the battery.

Top side showing terminal block pinout
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Data Logging
The large amount of memory and paging system were designed so that you may
download the data at the most convenient time for you.
The unit stores one second of data before launch detect and 16 samples a second(16Hz)
after launch detect.
The samples are stored as 16bit values. That gives you a resolution of ½ a foot in your
readings.
At this time download software is only available for Microsoft Windows based PC’s.
To download the data you plug the interface dongle into a USB port on your computer.
You may need to load Virtual COM Port drivers from www.ftdichip.com
From Device Manager verify what port # was assigned and if needed change it to a lower
port #.
The cable coming off the dongle is polarized and the connector has an arrow to indicate
pin 1.
Plug the cable into your altimeter.
The altimeter is powered through the USB port and should not have it’s battery
connected.
When connected the LED will blink quickly several times to indicate it is waiting for the
software to connect.
If you have trouble connecting you may need to reset the altimeter by disconnecting the
cable and reconnecting it.
Start up the PICO adjuster software and verify the com port setting is correct.
In the tools menu select ‘Download DATA’.
The Data Download dialog will open giving you several options to download the data.
Selecting ‘Read new flights only’ will ask the altimeter how many flights it has stored
then prompts you with the specified number of flights to verify download.
Selecting ‘Read ALL data’ will make the software download all the data upto the value in
the edit box labeled ‘Max samples to receive’.
While downloading the Samples read counter will increment.
Once the data is transferred to the computer it will show a nice graph of the data.
In the View menu select Details and add some details about the flight.
Then from the file menu you can store it for later recall or you can export it to a CSV
type file that can be loaded into any number of spreadsheet programs or even notepad.
This will save/export the currently displayed flight only.
If you have downloaded multiple flights then the current flight you are viewing will be
indicated in the status bar at the bottom of the screen.
You can page through the flights with the arrows on the tool bar or using the View menu
items Next and Previous.
Page through all flights you have downloaded and save each one as an individual file.
If you have not saved them then they will be lost when you open another file or close the
program.
Using the data memory you are not limited to the maximum altitude of 40,000feet.
Because the unit stores the pressure readings directly to the memory it is capable of
realizing the full range of the pressure sensor which is over 50,000feet.

Data Download dialog

Configuring
The altimeter is configured via software.
Verify the altimeter is connected to your computer.
In the Tools menu select Administer PICO.

Selecting the Connect button will connect to the altimeter and populate the data values on
the screen. The Connect button will also be re-labeled to ‘Disconnect’.
Page size is the amount of time each flight will record for.
Current page is the current page stored in the altimeter, where it will next log a flight.
Startup delay is the amount of time after the altitude report that the altimeter waits before
making a ground reading and looking for launch detect.
Launch Detect Altitude is the distance above ground used to detect launch.
Mark Events will cause the altimeter to store a value of maximum (0xFFFF) whenever
pin 3 of the header is brought to 3V. This is useful to mark events as they happen such as
a shutter closing. You can use pin 5 as ground.
Verify the values then select Write Values to PICO to store the values.
The details of what the program is doing is displayed in the Status window.
Typically the Current Page value will be set to zero so it can record the first flight in the
first location. If you want to recover old flights you can set this to some value so the
download section will read the value and download that many flights.
If you have trouble connecting try resetting the altimeter by removing its power source
for a few seconds.

Specifications:
Circuit board size
Weight
Maximum altitude
Readout
Launch detect altitude
Resolution
Power requirements
Total weight
Current

1.4 inch x 0.6inch
Under 4.5grams without battery
40,000feet ASL
Surface mount LED blinks value
25, 50, 100feet (user defined)
7feet at sea level
Min = 3.1V, Nominal = 9, Max = 16V
Under 6 grams with 1g 100mAh LiPo battery
6mA

Data Logging Specifications:
Sample interval
16Hz
Samples logged
32768
Sampling time
Over 34min
Sample resolution
6inch at sea level

Limited warranty:
This unit is warranted against defects in workmanship for a period of one year from the
date of purchase. The manufacturer will repair or replace the unit at its own discretion.
Misuse of or modifications to the unit voids all warranties.
Limitation of Liability:
In no event will the manufacturer, its employees or its suppliers be liable for any
incidental or consequential damages whatsoever(including, without limitation, damages
for loss) arising out of the use or inability to use this product, even if the manufacturer
has been advised of the possibility of such damages..
Some states do not allow the exclusion or limitation of incidental or consequential
damages, so the above limitations may not apply to you.
This unit is a toy. As such no claims are made or implied as to the suitability or capability
of this product in the manner in which you want to use it. The user accepts all
responsibility for use of the unit.

